
GTBPCUG                                                                                                                         July 2011 

 

 Issue 7                                     July 2011               24th Year of People Helping People!  

        G
TBPCUG 

          
July  2011 

        N
ewsletter 

Broadband2Go                Cont.        2 

Backing up                 3 

Backing up                       Cont.   4 

Word Annoyances   5 

Word Annoyances            Cont.   6 

Word Annoyances            Cont.   7 

Some Things to look into...   8 

Internet Security 

Internet Security               Cont. 

 

 

 

 

Don’t forget to visit  our 

club’s site at:                                    

http://gtbpcug.org 

As well Don Miller’s and 

Darrell Manns’ : 

http://www.dmanns.org/

dmiller/ 

  9 

10 

In This Issue 

 

Broadband2Go 
By John Roy, President, The PCUG of Connecticut 

www.tpcug-ct.org 

 

I have been itching to purchase an AirCard® for my laptop computer. 
We take several trips during the year with our Roadtrek motor home 
and, while Wi-Fi hotspots are more abundant these days, Instant Inter-
net access is really appealing. Unfortunately for this instant gratification 
you have to pay a big price. Being frugal I wasn't prepared to commit to 
a two-year contract at $60 per month for the privilege. 

 

For those of you not familiar with an AirCard, it is a high-speed wireless 
broadband card that gives users mobile Internet access on their lap-
tops, using a cellular data service. AirCards can be purchased from 
wireless providers in various styles such as USB, PCMCIA, Ex-
pressCards and as a portable router. It's interesting to note that AirCard 
is a registered trademark but used generically to describe these de-
vices such as we use Xerox and Kleenex. 

 

Last year my daughter needed daily email and texting capability that 
her present cell phone did not provide. She already had an iPod Touch 
but Wi-Fi hotspots were limited. I researched various options to find a 
minimal cost solution and focused on Virgin Mobile's Broadband2Go 
MiFi 2200 credit card router. The driving factor was Virgin Mobile had 
the cheapest data plans without any contract obligations. 

 

The MiFi 2200 router is unbelievably small just like a credit card and 
can serve five computers at the same time. There is an initial cost of 
$150 for the device but then you can buy air time to fit your needs. This 
device is extremely portable and will run four or more hours without a 
recharge.  
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After monitoring my daughter’s success with the MiFi 2200, and knowing we were taking an ex-
tended trip with our motor home, I decided the time and price was right for my purchase. Virgin Mo-
bile sells two broadband products with the same data plan options. In addition to the $150 MiFi 2200 
they sell a $80 USB MC760 device. The MC760 plugs into any USB port but unlike the MiFi router it 
is dedicated to the one computer. 

 

After reviewing the pros and cons for my situation, I chose the MC760. I didn't have a need for shar-
ing my hotspot with five computers, the USB device didn't require a battery, and I saved myself $70. 
Of course the best part is I was not locked into a contract and could buy time as needed. 

 

Is buying an AirCard from Virgin Mobile a "no brainer" for everyone? The answer is no but it should 
be on everyone's evaluation list. Here are some key considerations beyond the primary driver of 
saving money. Their cellular service is the Sprint 3G network with good coverage in populated areas 
or primary highway corridors but poor coverage in other less populated areas. You should check 
their coverage map to be sure you will have a good signal for your specific needs. 

 

There is some good news and a little concern on their data plans. Last year they offered a $10 (10 
day 100MB) and a $40 (30 day unlimited) plan. This February they increased the $40 plan to $50 
and put some speed restrictions beyond 5GB but the deal is better than competing providers. While 
the price hike was concerning, there is an unpublicized secret you should know. If you purchase ei-
ther device from Wal-Mart you are offered an optional $20 (30 day 1GB) plan. 

 

How the plans work is when you start using a plan it will end when either the time period or data limit 
is met. On the $50, 30-day unlimited data plan when you reach 5GB of data use your speed will be 
limited to 256kbps for the remainder of the time period. 

 

One final note is both devices have several neat software options beyond the basic application. 

 

The MC760 has a micro SDHC memory card slot and the capability of adding an optional antenna to 
increase range. Documentation is less than meager and only includes startup instructions but once 
initiated the setup is interactive. Most importantly you can find a detailed manual on line. If you are in 
the market for an AirCard or curious for more details, visit their website. 

 

http://www.virginmobileusa.com/mobile-broadband/ 
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Can I backup files to another partition on the 

same hard disk? 

Q: I am going to do a clean install of Windows 7 x 64 to hopefully fix some errors, which means that  

I need to back up my files. The problem is that I don't quite have the means to back up my hard 

drive. Can I simply create a new partition on my existing drive (1TB), copy my files to that, and then 

perform a clean install on the existing Windows partition? Afterward, I would transfer the files back 

and delete the "backup" partition. Would that work or am I heading in the wrong direction? 

A: Yes, but... there are risks. In fact, you're running a huge risk without even doing a thing.            

Because people often ask if backing up to a separate partition is a valid backup approach, it is not!           

You're Just Managing Data 

What you describe isn't really backing up. You're just moving some files over here so that you can 

erase that stuff over there. 

"Backing up one partition onto another where both partitions are on the same hard disk is, at best, 

only half of the solution, and, at worst, a disaster waiting to happen."  

And, as far as that goes, it's a fine, fine approach. In fact, I'm sure that I've done it myself at some 

point in the past. It's a fast way to copy some files around so you can wipe out what's on the primary 

partition and then copy the files back later. 

But I'm not going to call it a backup and I suggest that you not think of it that way either. 

For how you're using it, it's a fine approach. 

However... 

You're Not Backing Up 

This statement concerns me more than anything else: 

"I don't quite have the means to back up my hard drive." 

So, to put it perhaps too bluntly, you're willing to have everything on that hard drive disappear for-

ever if there is a catastrophic failure? 

If so, fantastic. You're good to go. 

But I suspect that that's not an acceptable scenario for you. As such, I strongly urge you to figure out 

some way to do real backups that will cover your assets should there ever be a need .   

                                                                                                                           Continued on the next page                                             
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A Different Partition is Still The Same Disk 

Backing up one partition onto another where both partitions are on the same hard disk is, at best, 

only half a solution; at worst, it's a disaster waiting to happen. 

It's very simple really: if the hard disk dies, all of the partitions on it go with it. If you've been putting 

the backups of partition A onto partition B on the same hard drive, then they both disappear at once. 

It's like having no backups at all. 

Backups on that second partition may be useful for some kinds of errors. Say that you deleted a file 

that you didn't mean to or that a bad sector crops up on partition A - the backup from partition B 

would still be there and available to copy back. 

But that completely ignores the more disastrous scenario of a catastrophic failure of the entire hard 

drive and the loss of everything on it. 

In case I've not been clear: don't do it. 

Backup, and Backup Somewhere Else 

So, find a way to backup. That's a given. 

But when you do so, backup in such a way that you're as isolated from the events that might cause 

you to need the backup in the first place. 

 Backup to a second drive, preferably external, to separate the backup from the original 

hard disk. 

 Backup to a second drive that you then disconnect, to separate the backup from software 

"going rogue" on your machine and deleting or corrupting data on all connected drives. 

 Backup to a second drive that you then disconnect and take elsewhere, to separate the 

backup from your home in case it's robbed or goes up in flames. 

Online backups are a possible solution as well, though they are less capable of handling complete 

system images or other large backups. 

In practice, simply doing only the first - backing up to a second external drive - will get you 99% cov-

erage for most of the problems that you're likely to encounter. 
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7 Little Word Annoyances and Their Easy Fixes 

By Nancy DeMarte, Columnist, Office Talk, Sarasota PCUG, Inc., FL  

March 2011 issue, Sarasota PC Monitor 

www.spcug.org 

 

Below is a collection of frustrating things that can happen when using Microsoft Word. These annoy-

ances can occur in any version of Word although most are geared to Word 2007 and 2010. In Word 

2003, the fix-it steps may be different. 

 

Annoyance 1 -- You accidentally press the Caps Lock key on your keyboard before typing a para-

graph. When you finish, you find everything in capital letters. 

The Fix: Rather than retyping the whole paragraph, highlight the text, then click the "Change Case" 

button (Aa), located on the Home tab in the Font group. Click "Sentence case" to transform your 

paragraph into normal sentences.  

 

Annoyance 2 -- You create a party invitation with a light blue background (Page Layout tab - Page 

Color). But when you print it, the background is white. 

The Fix: Office has set Word to not print full page background colors, probably to save users from 

wasting ink. You can, however, make the colored background print. Click the Office button, then 

Word Options -- Display. Put a check mark next to "Print background colors and images," then click 

OK. Until you remove this checkmark, all colored backgrounds will print. 

  

Annoyance 3 -- You're working on a document where you've set the text size to be a fairly small 10 

points. But you find that the text is too small to view comfortably while you're typing. 

The Fix: Drag the Zoom slider located in the bottom right corner of the Word window to the right to 

enlarge the screen view of the text. When printed, the text will be 10 points no matter how big it ap-

pears on the screen.  

 

Annoyance 4 -- You find that the spaces between lines of text in your document are wider than you 

want.  

The Fix: If all the spaces are wider than expected, you can change the line spacing for the whole 

document at once. On the Home tab, in the Editing group, click Select -- All to highlight all the text. 

Next click the Line Spacing button in the Paragraph group and select 1.0 for single-spacing or one of 

the other choices. 

                                                                                                                                                  Continued on the next page 
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Note: Word will not remove extra space after paragraphs when you choose a line spacing size. To 

remove extra space after a paragraph, select the paragraph before the extra space, click the Line 

Spacing button and choose "Remove Space After Paragraph." A more permanent way to create no 

extra space between paragraphs is to open the Paragraph group dialog box launcher (small diago-

nal arrow) on the Home tab and put a checkmark in front of "Don't add space between paragraphs of 

the same style." 

Annoyance 5 -- Every time you type an email or web address into a document, it turns into a click-

able hyperlink with underlined blue text, even if that isn't your intention. 

The Fix: The quickest fix is to right click the address and select "Remove Hyperlink." But this is only 

a one time remedy. To remove this action permanently, click the Windows button, then this se-

quence: Word Options -- Proofing -- AutoCorrect Options -- AutoFormat As You Type. Remove the 

checkmark next to "Internet and Network paths with hyperlinks" and click OK. 

Annoyance 6 -- You find that as you type, distracting wavy red and green lines show up under 

words and phrases.  

The Fix: Word is set to check spelling (red lines) and grammar (green lines) as you type. This is an-

other Proofing option which comes enabled from the factory. To turn off one or both of these fea-

tures, go to Word Options (Office button - Word Options) and click Proofing. Remove the check-

marks next to "Mark grammar errors as you type" and "Check spelling as you type." You can always 

check spelling and grammar after your document is complete by clicking Spelling & Grammar at the 

left end of the Review tab. 

Several of these fixes involve the settings found in the Options area of the Office 2007 menu (File 

menu in 2010). Options are available for all the Office programs (Word Options, Excel Options, Ac-

cess Options, etc.) These default settings were determined by interviews with thousands of people 

who use Office regularly in the workplace. If you find that the factory settings are causing you more 

trouble than help, changing them is a simple task. All Office users should take a personal tour of the 

Options menus, which resemble this Word Options window with the AutoCorrect box open: 
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Annoyance 7 -- You often save documents to the same folder which is buried within other folders in 

My Documents. It takes several clicks to find this folder each time you want to open or save a docu-

ment to it. 

Fix 1: You can find almost any folder on your Windows Vista or 7 computer by typing its name into 

the Start Menu search box just above the Start button. Often it takes only a letter or two before the 

folder appears in the search results. On the downside, you have to do this each time you want to 

open the folder. 

Fix 2: A way to make any folder immediately available is to add it to the Favorites section of the 

navigation pane. This pane appears on the left side of any explorer window where you are viewing, 

opening or saving files and folders. To make a folder a Favorite, start by creating or opening a file, 

like a document, and click Save As, which opens the Save As dialog box. This reveals the naviga-

tion pane on the left, showing a list of possible places to save the file. Navigate to the folder you 

want to make a favorite so that it is the last item in the history bar across the top. Then right click the 

word Favorites in the left pane. From the drop down menu, click "Add current location to Favorites." 

Your special folder will now appear in the Favorites list. It will also appear in the Favorites list of the 

other MS Office programs on your computer, such as Excel and PowerPoint. To remove a folder 

from Favorites, right click the folder and select Remove. 

 

Using a computer should be fun as well as useful. Take a few minutes to think what your personal 

computer annoyances are and try to find fixes for them. Customizing your programs makes using 

the computer much more enjoyable and efficient.   
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Some things to look at…                                    http://www.infopackets.com 

We took Ashampoo Office for a test drive, and we're not going back to 

Microsoft anytime soon. Read our full review and save 40% off your own copy 

by following the link below: 

http://go.infopackets.com/e20110407-01 

Our main page is updated daily with the latest stories available. To access 

those stories, click the main page link below. Otherwise, use the headlines 

and links further down this page: 

http://go.infopackets.com/e20110407-02 

More information about Windows 8 continues to emerge, though the 

details aren't coming from Microsoft. Instead, the recent information 

has been passed down by a pre-release version of Windows 8 ... 

http://go.infopackets.com/e20110407-03 

A leading security firm says targeting personal data is becoming less 

of a priority for online criminals. Instead, there's now a greater 

effort to unlawfully access corporate data, including trade ... 

http://go.infopackets.com/e20110407-04 

A controversial new Trojan virus is creeping onto Android smartphones 

everywhere, but poses no danger of compromising personal data or 

stealing confidential banking information. The threat is ... 

http://go.infopackets.com/e20110407-05 

Holding a 55 per cent share of the overall operating system (OS) 

market, Microsoft's Windows XP continues to be the world's most popular 

OS. But, Microsoft's newest web browser, Internet Explorer 9 (... 

http://go.infopackets.com/e20110407-06 

According to a new report from security firm Symantec, the volume and 

complexity of web-based hacker attacks continues to grow. Symantec says 

the total daily number of online attacks actually jumped ... 

http://go.infopackets.com/e20110407-07 

http://www.infopackets.com
http://go.infopackets.com/e20110407-01
http://go.infopackets.com/e20110407-02
http://go.infopackets.com/e20110407-03
http://go.infopackets.com/e20110407-04
http://go.infopackets.com/e20110407-05
http://go.infopackets.com/e20110407-06
http://go.infopackets.com/e20110407-07
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            Antivirus up to date? 

            Firewall? 

            Windows up to date? 

            Spy Ware? 

            See how to protect your computer at: 

                   http://gtbpcug.org/protect/ 

 

                                                                   More about Internet Threats 

                Is Your Internet Security up to Date? 

Microsoft to Release Mother of All Security Updates   By John Lister   

www.infopackets.com 
Microsoft has announced that Tuesday's security update will include patches for a record-breaking 

64 security problems. They include fixes for a number of particularly high profile problems an-

nounced in the past couple of months. 

The update will be made up of 17 bulletins. That ties for the record, though this will be a new highest 

figure for the number of individual fixes. 

One of the bugs that's being fixed involved a bug in the Windows Server Message Block ("SMB"), 

the system that controls networking and file-sharing. The bug was disclosed in February and could 

theoretically have been used to gain unauthorized remote access to a computer. 

At the time, Microsoft said it was unlikely this could be practically exploited, a forecast that has 

thankfully proven correct. (Source: technet.com) 

Web Page Bug a Tool For Hackers 

The same can't be said of a bug involving MHTML, or "MIME Hypertext Markup Language", a format 

for combining all the elements of a web page into a single file. 

While the bug, announced in January, initially appeared too complex to be exploited, it later 

emerged that hackers were using it in politically motivated attacks on specific websites. Microsoft 

has already issued a stopgap Fix It tool (which users had to manually download), but this update is 

designed to be a permanent solution, hence its rollout to all users. 

                                                                                                                         Continued on the next page 
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      Legal Notice 

      Bay Bytes, Copyright © 2011, is the official newsletter of the Greater Tampa Bay PC User Group, Inc.(GTBPCUG). The information in this newsletter is in-

tended to help our members. It has come from many sources and cannot always be verified. It is recommended that you obtain professional advice from software and 

hard   ware distributors, manufacturers, salesmen, or other professionals dealing with the subjects that appear in this newsletter. Unless specifically stated otherwise, 

the opinions expressed in Bay Bytes articles and columns are those of the individual authors and do not represent an official position of, or endorsement by 

GTBPCUG.GTBPCUG is not affiliated with any company, vendor or equipment manufacturer. Permission for reproduction of Bay Bytes in whole or in part is 

hereby granted to other APCUG user groups for internal, non-profit use, provided credit is given to the author, GTBPCUG Bay Bytes along with the copyright notice. 

Other reproductions require the prior permission of the editor. When published, please send a copy of your newsletter to  

editor@gtbpcug.org  or mail to P.O.Box 501, Brandon, FL, 33509-0501. 

Some Material appearing in this newsletter had been send to the editor by:  

Parker Monroe and Dick Evans 

Windows XP Through Windows 7 Affected 

The security issues are widespread and affect Windows XP through Windows 7. Of the 12 bulletins 

that deal with issues in desktop editions of Windows itself, 10 affect Windows 7, 11 affect Vista and 

all 12 affect Windows XP. 

As for what the record number of updates signifies, that's more open to debate. 

While it's true that Microsoft has intentionally released all but the most urgent fixes for Internet Ex-

plorer in batches every second month, the fact remains that Internet Explorer is almost inherently the 

primary target for attacks by hackers due to the number of people using it online. (Source: computer-

world.com) 

Another explanation is that more problems are coming to light now that Microsoft is more flexible 

about the way it deals with independent security researchers. 

At one point it demanded researchers keep details of bug discoveries completely silent. Today it is 

more likely to simply request that it be given time to begin working on a fix before hackers hear 

about the bug and begin trying to exploit it. 


